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Our Mission
“Provide the research community technology to improve
efficiency and accelerate innovation”



ARM Software is Trusted by Over 10,000

Researchers and Scientists Worldwide




Use ARM for all stages
of an experiment.

To plan and create
protocols, to
randomize and
manage trials, to
analyze data and
report the results.



ARM software provides a defined structure to enter information
consistently, with master list dictionaries to standardize
vocabulary, and has tools for every step of an experiment.







ARM the Industry
Standard

The top 12 Agro-Chemical
companies now depend on ARM
Software worldwide.




Field License
Bundle

This bundle brings ARM to the
field to help improve efficiency
and accuracy.




Leaf Wall Area

Software solution for an industry

specific challenge. ARM facilitates
the research techniques for future
regulation of product applications.




Weather Data Import

Collaboration with ClearAg (lteris) to
build a new feature that allows you to
import weather data.

ClearAg offers specific information by
utilizing meteorology, agronomy, land
surface modeling and crop production
at specific GPS coordinates.




Marketing & Support

We hired a full-time
sales and marketing
associate to focus on
our client
communications.



The Year Ahead




Training Initiatives

Continue to expand our tools
and resources to make it easier
for our clients.

- Tutorials
- Coaching Events
- Webinars




Product Release

Work as a team to ensure
every client is aware of the
new features and how to use
them to make their work more
efficient.




Precision Ag

Work closely with South
Dakota State University to
provide support with
development and
implementation.

* Correlation of known
variability
 UAV data analysis




Client Driven
Development

Working closely with our clients
to implement additional features
and intuitive reporting.

Providing new features
throughout the year.



ARM improves efficiency, increases accuracy, and

promotes better quality of results.







Repeated Measures
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Repeated Measures

Avalable Heports
. +- Protocol
Analyze repeated assessments across time g
Aasesament Footnotes
Enhancement
* Powerful statistical analysis which enable the Summary .
control of factors which cause variability between vl
treatments over time. aciogial AOV Tak
* Provides analysis of treatment means over time to e
determine if there is an overall time effect on the Dose-Response Analysis
Standardized Summary

treatments performance.
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Repeated Measures

e et

Cancel Graph Options Help

1.

Pest Code ERYSGT ~v| ERYSGT v| ERYSGT viERYSGT v ERYSGT
Pest Name Powdery midew of whe | Powdery mildew of whe ! Powdery mildew of whe M| Powdery mildew of whe | Powdery midew o 2
Crop Code VTRZ-'\W vrTRZAW ~| TRZAW ~| TRZAW v| TRZAW *
Crop Name \‘iﬂer wheat ™ ,‘f‘,ﬁr,'t,e,f,@?‘?t ™ Wlnter yyheat ™ Winter wheat v| Winter wheat
7Rating Date _Jm~8-2014 VEJun-22-2014 _V§ Jul-5-2014 V3 Jul-15-2014 ~| Aug-3-2014
Part Rated » PLANT v P v PLANT ~| P ~| PLANT v P M| PLANT M| P v PLANT M P
Rating Type »COUDlS 3 ViQOUDIS i V}EJOUDIS ;V§{AC0UDIS : v FZOUDIS 3 .
Rating Unit _»PERCENT VELPERCENT Vi _PERCENT V{ PERCENT ~ PERCENT
Number of Subsamples 1 1 1 1 1
ARM Action Codes v M M| v
. ' . - » o - U - oLy - 4
Heading Matched Felds| ATINGS Previous column matches B
Pest Code N Selected assessments have inconsistent I Selected column fields
== intervals of 14, 13, 14, 15days | : .
Crop Code - ® | i 1 | Pest Code=SEPTTR; Rating Type=PESSEV; Rating Unit=%
Rating Date Modéfy the matched columns by clicking a 2 | Pest Code=ERYSGT; Rating Type=COUDIS
Part Rated @ new column to match, selecting a previous 3 | Pest Code=ERYSGT; Rating Type=COUDIS
match or editing the ‘Matched Fields’ 4lp PHYTH =ZEAMD: R Tvoe=DILOGR U<
Rating Type CouDIS g Ok View Selected to view only the est Code THB; Crop Code=ZEAMD; Rating Type=DILOGR; Rating Unit="%
Rating Unit PERCENT selected columns _5_ Pest Code=ERYSGT, Rating Type=COUDIS; Rating Unt=PERCENT
ARM Adlon Codes 0 Chick ‘Next'to continue
Clear Columns matched

Define assessments for analysis:

Select a column to find
potential repeated
assessments.

ARM proposes fields to
match other columns.

Diagnose issues with
column selection.

Or load from history of
column matches.

Repeated Measure
Repeated Measure
G-All7_SDTR_Inoc_001
AUDPC_1
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Pest Code ERYSGT
Pest Name mildew of wheat
Crop Code TRZAW
Crop Name Winter wheat
Repeated Measures
Rating Type COUDIS
Rating Unit PERCENT
Number of Subsamples 1
Trt Treatment Rate Appl
MNo. Name Rate Unit Code
. . TABLE OF Treatment MEANS
Means and comparison letters for: tSurekil 3 1b aila A 2041
. 2 Sure Kill J1baifa A J95¢c
* Treatments Ratlng Dates 3 Sure Kil 3 Ibai/a A 318 e
] . ] 4 Sure Kill 351bailaA 182 h
* Treatment x Rating Date interaction 5 Sure Kil 31bai/a A 330 d
6 Sure Kill 41baiaA 437 b
. . . 7 Super Stomp 25IbaifaA 200 g
Apply correction to adjust for correlation (H-F-L or G-G) | &0ntreated 675 a
Error DF Correction (H-F-L)
;ukeg'sygtl P=.05 2} ag
tandard Deviation
Repeated Measures AOV table oV 579
TABLE OF Rating Date MEANS
REPEATED MEASURES AQOV For D ERYSGT Blumeria graminis tritici Powdery mildew of at TRZAW || 1 Jun-8-2014 (Data Col 1) 23e
PLANT P COUDIS PERCENT 1 2 Jun-22-2014 (Data Col 2) 357 d
Source DF Sum of Squares Mean Square F Prob(F) HSD (.05) Vaw 3 Jul-5-2014 (Data Col 3) 481b
Total 220.0 141626.962500 4 Jul-19-2014 (Data Col 4) 494 a
Replicate 5.0 65.637500 13.127500 3.127 0.0195 0.22323 5 Aug-3-2014 (Data Col 5) 415¢
Treatment 7.0 51065.995833 7295.142262 1737.776 0.0001 .10 Error DF Correction (H-F-L) 0.90
Treatment Error 35.0 146.929167 4197976 -0.246155 ||Tukey's HSD P=.05 1.31
Rating Date 3.6 71570.358333 17892.589583 3295.895 0.0001 1.3] g‘ﬁl”dﬂrd Deviation g-gg
Treatment x Rating Date 25.1 17909.441667 639.622917 117.821 0.0001 5.35 '
Error/Residual 143.6 868.600000 5.428750 5.428751 TABLE OF Treatment Rating Date MEANS
1 Sure Kill J1baila A 880

o ' 1 Jun-8-2014 (Data Col 1)
i ' : 2 Sure Kill 3 1baifa A 00p
ARM Powered by GDM Solutions 2 Sure kil  3lbaiaA
— » e



Repeated Measures
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Treatment x Time Graph

e Plot treatment means
over time.

* Visually identify
treatment interaction
across assessment
dates.

ARM Powered by GDM Solutions _—



Study Review
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Trial Settings

zeneral

Review Study

* Track whether a trial has been reviewed

e |dentifies who marked as reviewed

=
Mark a trial as Reviewed A
I
]

 Trial Settings > General tab

| &1 Reviewed Trial (GYELMA-Matthew Eisinger) |

* 'Trial Reviewed' action is automatically
logged in Notes tab of Site Description

| Site Description

* Checkbox is cleared when any change is et | Devistons | fratoces Cammen| L
. . Date By Motes
made to data N the trlal Now-272018  Matthew Elsinger  Aufomaticaly added by ARM.: Tral Reviewed

ARM Powered by GDM Solutions
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Review Study

Create a review group Study Rules - Rule 1 of 1

* 'Review' study rule defines |Rule | Rule ID Edtor | Field Condition
who is allowed to mark a :
trial as reviewed

* Condition field defines who to include in the group:
* just protocol or trial owner(s)
* everyone in my company
* Anyone (i.e. no group)
* Example: Sponsor wants to ensure the study is reviewed internally.

Contractor can still create their own separate review group to review before
sending back to the sponsor by adding another 'Review' rule for their company.

Feview Trial Trial Evernyone in my company

ARM Powered by GDM Solutions
S ——




Study Rules
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Study Rules

Merge Study Information

 Easily copy information from study to
study.

* Replaces “Save As” function.

Enhancement

* Choose to not merge study rules if the
study is originated by your company.

» Offers new flexibility for internal
researchers.

Feature in action |

Tools | Table  Utilities

v Spelling
Renumber
Sort by...
Transform...
Recalc Transformations

Convert Yield...

I Merge...

Data Collector...

Merge Study Information

sections

[ ] Add header
[ ] Add treatmerts

I Merge study rules for selected sections I

ARM Powered by GDM Solutions
S ——




Merge Study Rules

Enhancement

 Limit study rules merged to only
selected protocol/site description
sections.

ARM Powered by GDM Solutions
S ——

v

Tools | Table  Utilities

Spelling

Renumber

Sort by... 3
Transform...

Recalc Transformations

Select Sections to Merge

Convert Yield...
Merge... ]
Data Collector... 3

Sections

General Trial
Objectives/Conclusions
Contacts

Crop Description

Pest Description

Site and Design
Maintenance

Soil

Weather

Application

Crop Stage at Appl.
Pest Stage at Appl.
Appl. Equipment
Treatment Appl. Comments

Motes
Measdiatinnz

Merge | m
L]
L]
L]
L]
'''''''''''''
L]
L]
L]
L]
L]
]
v
Cance

Show All
Hide All

Help




Validation

Always Validate St“dies Trial Validation Messages
* Validation ensures all protocol e
criteria has been met. B %/ Validation Messages

=g Ermors
a Required Site Description field is blank: Tral Status® (Study Rule 55)
a Required Site Description field is blank: Climate Jone’ (Study Rule 54)

E n h a n Ce m e nt @ Wamings: None, Information: MNone

 Validation messages now list the
study rule number that triggered the
error or warning message.

Feature in action

ARM Powered by GDM Solutions



Rule Set Name Identification
* |dentifies/Verification of the correct rule set used within study.

Enhancement

* The name of the loaded rule set now displays in the editor heading when a
rule is selected within the table.

Study Rules - Rule 2 of 4 | Rule Set: hiddenHdsGDM

Feature in action [m= ru=0 Editor Field Condition
1 Limit validation list Asgessment Data Header Crop & Pest in Site Description  Always
:
= 3 Hidden Field Treatments Description if nat in my company
4 Hidden Field Treatments Comment 2 Iif nat in my comparny

ARM Powered by GDM Solutions



ARM Powered by GDM Solutions



Tools: Merge

Existing blank treatments are automatically removed when
performing a merge with another study.

Treatments - Line 1 Treatments - Line 1
L-!_r:te ':qert Type Treatment Name Form Cone | Form Unit _Frigr: L-!-r:te r:qrz Type Treatment Mame Form Conc | Form Unit _Fl_;gr;
1 |1 W Il 1 m CHK Untreated Check
2 * 2 HERE Banvel 720 348 GAL L
3 3 |3 |HERB |FallowMaster 251999985 |GAIL SC
4 4 |4 HERE | Marksman 384 GAL F

S <- Before and After ->

ARM Powered by GDM Solutions
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Tools: Import Weather

Progress bar added during Weather import

e The weather is imported from outside the ARM software.
* This ensures you know that progress is being made ©.

Importing weather data from ltens ClearAg 34% X

Requesting Daily Soil Conditions from Reris ClearAg
Received Daily Soil Conditions

Requesting Daily Histoncal Weather from lteris CearAg
Received Daily Histoncal Weather

Requesting Daily Histoncal Climatology from ttens ClearAg
Received Daily Histoncal Climatology

Saving dally weather in curent trial

34%

| Cancel

ARM Powered by GDM Solutions
S ——



Study Settings
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Trial Time Zone

Why is a specific time zone needed?

* Ensure the alignment of the trial location in relation to time zone to
external data providers.
o New Weather API will align location specific weather for a
particular time, such as per application.
e Trial Settings > General tab

Tnal Settings

General Design Treatment Application Layout

Replications: 4 15 Trial location time zone: | Amenca/Chicago o

ARM Powered by GDM Solutions



Layout Options

Clarified 'buffer' option text = T etings
e Changed to 'Alley width' - a more
commonly used term

 Previously called 'Buffer' between
blocks or plots

*  Protocol/Trial Settings > Layout tab Aley wickh between blocks:

Alley width between "Plot” expermental units:

ARM Powered by GDM Solutions



New Options - Liters M size

Treatments 1
Liters as an Overage Option Heplications :
Plot® ELI size 2amé

 C(Clients may have equipment that requires

a very large amount of overage. Instead Application volume | 20 L/ha

of using ML’s (1000's), you now have the Mix size unit mL e
option of Liters. Example: 2150ML vs, Minimum 200 mL
2.15L. Overage: 215 L

* (Can be entered in the Settings >
Application tab or, Appl. EQuipment > Mix @) | Calculated mix size
Overage, Unit or, Application Plan. () Userdefined mix size

ARM Powered by GDM Solutions



ug!

General Design Treatmert Application | ayout

Application volume: 'E’Dﬂ'—| L/ha w Arelim=tine Blam
Enhancement e e B
Mix size unit IL e
* Brings consistency to the unit names - ﬁ; e R e e maeet: 25m2 Pl experinents

whether you are in the treatments © | Cootod i aae | 2151 |
editor, settings, or application plan. Ll ey

Mix Size Unit | Description 1 Description 2
FT3 cubic feet of mix quantity of soil or media to treat
: : : of mix for preparing a granule or dry camer
.« S Appl b H—
ettl ngs > pp Icatlon ta g seed grams of seed quantity of seed to treat
GAL gallons of mix for liquid sprays using a diluent
kg seed kilograms of seed quantity of seed to treat
e Aool. Equi Mix O L kil mmsug s d
ppl. eEquipment > Mix Overage, L
LB seed pounds of seed quantity of seed to treat
Unit Or Application Plan m3 cubic meters of mix quantity of soil or media to treat
) mlL milliliters of mix for liquid sprays using a diluent
seeds seeds ffor /seed rate units) for seed treatment studies when rates are /seed or /unit
= units units of seeds for /unit rate units) | when treatment rates are /unit, /plant, /n plants, /tem, or /seed
41 YD3 cubic yards of mix quantity of soil ar media to treat
1| B =l -
Bt Fiw » Remove Fitter Add to Personal Ca

ARM Powered by GDM Solutions




Site Description
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*Coming in ARM 2019.1

Track Trial Progress™

General Tnal Information

Discipline: herbicide Data Location
W h d m nt t r. I r r ? Trial Status established Trial Reliability: =
y O C u e I a p Og e S s ° Inal Usage/Type Screening/Exploratory ARM Trial Created On: Sep-19-2018 |
Initiation Date wll Planned Completion Date: |Aug-19-2014 |~

* Requested by sponsors.
* Provides visibility and credibility to timely data entry.

* Added new fields to track status and progress throughout the season.

Pest Descnphtion
Insert Pest with Shift+F 7, Delete current Pest with Shift+F8

—_ Pest1Type: W+ Code: |GGGAN ~||Annual grasses ol
= Common Name: |Annual grasses ol Enty Date:  Jul-20-2018
Attnbutes: w

ARM Powered by GDM Solutions
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*Coming in ARM 2019.1

Track Trial Progress™

Additional new fields to track status and progress throughout the season.

* Application tab > Appl. Entry Date

Application Descniption
D
* Assessment Header > Data Entry Date P ~—ryTr -
[ e——— - T— Appl. Start Time: 11:15 AM
Column Number 1 Applcaton Method SPRAY b
Part Rated LEAE ™~ C y Apphcabton Timing: POSPOS A
lic Plac S
e PHYGEN . Apphcaton Placement BEROFOL
_ Appled By: i
Hating Unit % hd
Appl Entry Date. Sep-19-2018
Mumber of Subsamples 1 . .
Air Temperature Start, Stop 195 C v
Llata Entry Dale Sep-T19-L0718
Trt-Eval Interval '7 DA-C

ARM Powered by GDM Solutions




Protocol Instructions

Support Rich-Text Formatting

* Preserves the format from the original protocol through to the Trial.

Site Description

Crop Stage at Appl. Pest Stage at Appl. Appl. Equipment Treatment Appl. Comments Notes Deviations Protocol Comments
Site Information

FProwde weather data as follows {min. requirement).

as from T day before application up fo the final assessment average, main and max temperature and precipitation on a
danly basis. => Data from the nearest weather recording station should be aftached as a file in standard format (for
example Excel lable, Comma or fab separated ists ) Indicate the distance of the fnal site fo the weather station

Comment on any extreme weather sifuation in tnal comments.
Mention every imgation apphication including all details in the DAT file

For assessments follow the Dats header information in detar

Data to Collect L L
Do an assessment on general Phyfotox atf every wisit fo the tnal site. In case any phyvio 1s wsible, assess on each of thes
effects separately (for example smaller leaves and chiorosis). dssessments should be done on frequency and intensilty
of the symptom. Craate an adeguate header for these specific assessment n case of insecuniy of the codes fo use,

make sure fo fully verbally describe the hpe of assessment in the foolnote/
Assess all effects on any other than the pre-defined target weeds as well as on beneficial insects!

Raport all other reatments in detail in the “crop maintenance” chapler of the DAT file

ARM Powered by GDM Solutions

[Nomal] v Aid ~10 v|B 7 Uyl
S T T
L L L L L L L
Provide weather data as follows (min. requirement):
- |» asfrom 1 day before application up to the final assessment average,
daily basis. == Data from the nearest weather recording station shouls
example Excel table, Comma or tab separated lists ..) Indicate the di:

|

“ = Comment on any extreme weather situation in tnal comments
» Mention every imgation application including all details in the DAT file

or assessments follow the Data header information in detail

o Do an assessment on general Phytotox at every vsit to the tral site. |
these effects separately (for example smaller leaves and chlorosis). A

ol intensity of the symptom. Create an adequate header for these specifi

to use, make sure to fully verbally describe the type of assessmert in

- » Assess dl effects on any other than the pre-defined target weeds as v

" |Report all other treatm ents in detail in the "crop maintenance" chapt




Collapsible Repeating Sections

Fixed:

* Repeating section panels now
resize after displaying hidden

fields.

ARM Powered by GDM Solutions

Site Description

General Trial  Objectives/Conclusions  Contacts  Crop Description | Pest Description  Site and Design ~ Maintenance  Soil

Crop Description

Insert Crop with Shift+F7, Delete cument Crop with Shift+F8

Weather Application Crop Stage at Appl.

Pest Stage at

- Crop 1: |THZP\W v||Triticum aestivum (winter)

v| |Wirrter wheat

Vl

B Variety: | Local

V|

BBCH Scale:  BCER

Crop Group:

Description: | v| Maturity Group: | vl
Seed Size, Unit: | | | vl Mursery Date:
Seed Shape: | v| Planting Date:
Plant Shape Planting Method: dhiledl
Spacing within Row, Unit: l:l Harvested Width, Unit: M e
Rows per Plot: |:| Harvested Length, Unit: D
Planting Density, Unit: | | | o Harvest Equipment: |COMBINE A
Soil Temperature, Unit: |:| % Standard Maisture:
Perennial Age, Unit: ’_| ’—v| Plant Arangement: ’—v|
I ™ I ™
- e = = =
B Variety: | v| BECH Scale: Crop Group:
Description: | v| Maturity Group: | vl
| ] | . - |




*Coming in ARM 2019.1

Header
® S P~ * Title:
Trlal Orlgln Study Rules
Trial ID: |Smd\r Rules | Location: |GEHMANT ﬂ
. .. Protocol ID: [123a 1-5 | Investigator: Matthew Elsinger
Why track the trial origin? o
* Helps answer budget questions. Conducted Under GEF e

* Valuable to the R&D division.
* ID’s in-house, contracted or by a public institution trials.

Trial Location
Insert row with Shifi+F7. Delete current row with Shift+F8
e
Trial | MNumber
Tral 1D Responsible Site | Origin Jof Trials  Site Requirements
123215 |RE.Cearch v e M5
123a6-7 Debra Dooley'sData ] | 12
123 a 8-10 Fred's Quality Data d 4 C 13
“—

Header editor > Trial Origin or,
Trial Establishment Guidelines > Trial location Table

ARM Powered by GDM Solutions




Application Equipment and Plan

Auto-Fill default settings for application planning fields.
* Intuitive way of using Settings set to default and fill out the plan.

Application Information
Application Date Aor-15
Fow Sides Applied
Spray Volume, Linit 230 L/HA % e
: 25 e
Enhancement Minimum M Treatment ers

* Auto-fills with default entries when clicking in a blank field for mix size, mix
overage and spray volumes.

ARM Powered by GDM Solutions




Assessment Data
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View Options

Show more than one type of entry when matching on a field.

Column fiker
: ‘? Prompt Match Sart Visible |
How does it work: — -
Select multiple items for the “Match” column  |F=tina Tvee (A 5}
F- |t Rating Linit 8l 21 | OK I
lter. :
Sample Size, Uni E :fg}EA
MOICON
Collection Basis, Unl [] PESSEV
[]  PHYGEN
Reporting Basis, Lin [] WIGOR v
Gear | Show i
[ ] Display sort as tabs Hide Al

ARM Powered by GDM Solutions



AUDPC Transformation

Define Data Column Matches for AUDPC

Enhancement during AUDPC

* Allows selecting multiple values for match ® cds
fields.

* Lists columns currently matched.

* View only selected/matched columns on
the assessment data editor.

Where is this feature?
e Tools > Transform, select AUDPC

ARM Powered by GDM Solutions P



Plot Pictures

Include Column ID in assessment image file name

* Helpfulwhen aftaching

images for multiple Direction S——
(@) By column across Plot’ experimental unit P
a SSGSS m e ntS ta ke n () Across columns within “Plot” expermental unit 1= Plot: 4 |
Columnz: |1 = _ -
on the same day . A eEOse  [E
ort order —
() "Plat’ experimental unit (®) Assessment Aem.Date: |3 = Coumn 1016 [
() Treatment () Harvest Sgr?-.[;[:;ni'rrtss: C (Trt, Plat, Sub, Col) prefix to file name
[ ] [}
Mumber of images per "Plot’ experimental unit within -
W h ere is t h IS feat ure ? e 1 12| [G-AI7_Fung_T0003 Jul-152019_P101_C2
. 5Sub | Rep | Cal | Flot | Trt 1
* Assessment data editor > T

Properties Panel > Attach

ARM Powered by GDM Solutions



Tablet Data Collector (TDCx)
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Record GPS

Display the current position in real-time * e
* Researchers now can determine the accuracy of the e
GPS device while documenting coordinates. i o
* TDCx will display: GPS coordinates, accuracy and Rod (11101
altitude.
Where is this feature? 1
Choose “Tablet Read GPS Editor” =y e el Y e

ARM Powered by GDM Solutions
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Properties Panel

Increased size of Pin button

* Previously was hard to click on
the small Pin button to unlock a
Properties panel when using a
stylus (or finger) on a tablet

Column 1 Properties o
] ]

ARM Powered by GDM Solutions



ARM Migration
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*Coming in ARM 2019.1

Migrate Settings*

Copy settings when moving to a new PC

* Copy personal lists, report
sets, ARM settings to new
computer

o Would you like to create a migration package?

A migration package eases the transition to a new computer by

retaining personalizations such as personal vahdation hists and report
gets,

Warning: once deactrvation occurs, the ability to create a migration
package is disabled.

Click "Yes' to create a migration package.
What's new? Click 'No' to skip creating a migration package.
[ ]

Prompt to create package before
deactivating the old PC.

Yes Mo

ARM Powered by GDM Solutions _—
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Spray Seeding Plan

Why minimum mix size calculator?

 This helps determine the minimum mix needed.
* Proactively plan for your trial with this calculation.

Reps: 4 Appl Code: A Plots: 2.5 by 10 meters

Spray vol. 250 Lha Mix Size: 2.65 L (fotal for 4 plofs; minimum=2.5 L, overage=150 mL)

Trt | Treatment Form Fomm Form Rate Appl Spray Volume Mix Mix |Amt Product | Rep

No. [Name Conc Unit Type Rate Unit Code Volume Unit  Size Unit {to Measure | 1 2 |3 |4
3| Tub 250 G/L EC 1lha ABC 250 UHA 265L 106 mLU/mx |101 | 202 [301 | 402
1 | Untreated Check ABC 102 | 205|303 | 401
4 | Tilt 250 250 G/L EC 0.5 ha ABC 250 UHA  265L 53 mL/mx  |103 |204 | 305|404
2| Tub 250 G/L EC 0.5 ha ABC 250 UHA 265L 53 mL/mx  |104 |201 | 302 | 403
o | Mico B0 600 GIL EC 1.51Ma AB 200 LIHA 265 L 129 mUmx 105 |203 {304 | 405

Enhancement

* ARM reports the bare minimum mix size needed to cover the area of
all 4 reps.

ARM Powered by GDM Solutions




SE Definitions
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*Coming in ARM 2019.1

SE Definitions™

SE Definihons
Inzert SE Definibon with Shifi+F7, Delete current SE Definition with Shift+F2

Plan and define standard evaluations | 2

(SEs) and tasks to use in the study e e s .

 Simpler than importing SEs from file into % of infected leaves Fresh yield grain
assessment data editor S D (N leaes). TIOGT" | inko /... m2

nb of infected
leaves in FOS97A)

Use Tools > 'Build Header, Tasks' to create P art Rated EAF M  Moran M
the SEs and tasks defined in this tab Rating Type PESING VIWEFRE v
g::::: ;::e i LEAF : - M2 :

Multiple rating timings create columns  |coiecionsase SHOOT V|1 | PLOT
for each timing code S y—— LEAF ¥ M2_ ¥
e Two-column SE FO97_C2 times 3 rating ARM Action Codes | TIO[1] . v
timings A1-A3 = 6 total data columns Pest Type, Code v | v

Crop Code v P

ARM Powered by GDM Solutions
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*Coming in ARM 2019.1

SE Definitions™

[y e—
SE Definitions

1. D | S p I ay S EN ame I |St Insert SE Definition with Shift+F7, Delete current SE Definition with Shift+F8
2. SeleCt an SE’ can Rating Timing I v

_SE_ _Name 1

search/filter descriptions [Erereres
. SE Name | SE Description A |Preview
3. Preview assessment ot Damme o e ) :
. . F029 % Disease on surface of leaf 2 SE Name FOS7A Fog7.C2
columns defined in SE IS0 | % Duease on face of s 3 Pt ot s
FO91 . Disease on suface of leaf 4 Rating Type PESSEV PESINC
F0g2 % Disease on surface of leaf 5 Rating Linit LAREA
F033_C2 | % of infected stems (N stems). (x/N)*100 (note: "% = column Sample Size, Unit LEAF LEAF
F054_C3 | % of nfected pods [n plants) (FOS4B / FO94A)"100 Collection Basis, Unit SHOOT SHOOT
Ca n a I S O d efi n e ta S kS O n t h i S FOS5_C2 | % of irfected leaves (N leaves). (x/N)*100 (note: *x = colum Reporting Basis, Unit LEAF LEAF

FUS6_C2 | % of infected leaves (N leaves). (x/N)" 100 (o= colum ARM Action Codes TIO1]

tab to add to Schedule editor (.

FOS9_C5 | % of fruits with Russeting - Disease index: (([FO994)+2°[F0%4
FI00_C2 | % of irfected leaves (N leaves). TIOx]" (note: "x = column r
F101_C2 | % of infected bunches (N bunches): (x/N)*100 (note: *x = ¢
F102_C2 | % of infected bunches (N bunches). TIO[x]" (note: % = colul

F103 Count of spots per plant
< > v
(All) B A

ARM Powered by GDM Solutions Active Fer b Remove Fiter Add to Personal Cacel | B
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